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House. All company and product names mentioned in the manual may be trademarks or 
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 Overview 
Spb Pocket Plus gives you the tools to extend the usability and capability of your device. 
With Spb Pocket Plus you can quickly launch your favorite programs from the Today screen, 
show the status of the battery and storage cards, and adjust the backlight. Some other 
features include; compressing and uncompressing .zip files, smart scrolling in Pocket 
Internet Explorer and other programs by a simple finger or stylus drag, speed up your 
Pocket PC by closing running programs, switch quickly between active programs, boot in 
safe mode to troubleshoot Windows, open or save your files to/from any folder on your 
device, open multiple internet web sites at the same time using tabs, place a taskbar 
battery indicator at the top of the screen in all applications, and much more.  

Software Features 

Today Plug-in 
Spb Pocket Plus Today plug-in is a powerful tool that allows 
you to quickly launch your favorite programs right from the 
Today screen. It also shows you the remaining battery life, 
amount of free storage space on the internal memory and the 
storage card, and a backlight indicator. The Today Plug-in 
tabs will make it easy for you to access all of your Pocket PC 
settings and perform very important operations. The Spb 
Pocket Plus Today plug-in includes many utilities to give you 
more control over your Pocket PC.  

Smart Scrolling  
The Smart Scrolling feature allows you to scroll through lists, 
e-mails and surf the web making it smoother, faster and more 
comfortable to use your device.  Control the speed of the 
scroll with your finger or stylus anywhere on the screen. You 
can move any window's contents around by simply dragging 
your finger or the stylus. 

File Explorer  
The File Explorer feature adds essential tools to your system such as ZIP support (compress 
and uncompress .zip files), file encryption (protect your files with a password), the ability to 
format your storage cards, and view file properties. 

Close Button 
The standard behavior of Windows Mobile is to minimize the application when the X-button 
is tapped. This means the application will not be closed and continue to use memory while 
in the background. Speed up your Pocket PC by closing memory intensive programs that 
would normally stay running in the background. Applications can actually be closed with a 
single tap on the X-button. In addition, a task manager menu will appear if you tap-and-
hold on the X-button. With the task manager you can easily switch between all active 
applications. 
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Open/Save Dialog 
The Open/Save Dialog will extend the abilities of the standard Windows Mobile File 
Open/Save dialog which allows you to see only the first level of the storage hierarchy. With 
Spb Pocket Plus you can browse folders at any level to open or save your files and folders in 
main memory or the storage card  

Buttons  
Enhance the functionality of your hardware buttons by adding a tap-and-hold action. Assign 
actions such as switch between active programs (Alt-Tab), and backlight change using a 
button, keyboard navigation in the Today plug-in. 

Pocket Internet Explorer 
Enhance your Pocket Internet Explorer to do much more with 
tools such as Tabs (to open more than one page at the same 
time), Smart Scrolling, Fast Search, full screen mode, save as 
(to save pictures or a web page), and view the webpage 
source. 

Taskbar Battery Indicator  
The Taskbar Battery indicator stays at the top of the screen in 
all applications as a bar or dynamic icon. It takes on the 
colors of the active theme, so it always matches your system 
theme.  

Safe Mode 
The purpose of Safe Mode is to allow you to troubleshoot 
Windows and determine what is causing it not to function correctly. Once you have 
corrected the problem, then you can reset and Windows will load normally. 
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Installation 
Installation of Spb Pocket Plus 4.0 is a very simple process and takes less than five minutes 
to complete. The following installation guide will help you. 

System Requirements 
Make sure your system meets the following minimum requirements before 
installation: 

Windows Mobile 2003, Windows Mobile 5, Windows Mobile 6 Professional or 
Classic. 

Installing   
After you have downloaded the Spb Pocket Plus distribution file you should install it to your 
device. For a successful installation you will need a Pocket PC device attached to your 
Windows desktop PC. You will also need Microsoft ActiveSync software in order to install 
Spb Pocket Plus to your device. 

When you run the software installer on your desktop PC it will ask you to accept the license 
agreement and will start the installation program. You will be prompted to select which of 
the Spb Pocket Plus components you want to install. A list of components will be displayed 
for you to choose from. It will also display the memory space required on your device. 
Spb Pocket Plus should not be installed on the storage card. Spb Pocket Plus is a system 
service and for reliable operations we recommend you to install it on the main memory. 

Note: Microsoft ActiveSync works only with Windows XP SP2 or earlier. If you have 
Windows Vista, your synchronization settings will be managed through the Windows Mobile 
Device Center. Windows Mobile Device Center is available through the Windows Mobile 
Device Center page. 

Registration  
You will be able to use Spb Pocket Plus until the end of the trial version period of 15 days. If 
you have not registered Spb Pocket Plus within this timeframe, you will need to do so to 
continue using it.  

To obtain the serial number you need to purchase an Spb Pocket Plus software license. You 
will receive your serial number by e-mail. 

Uninstalling 
To remove the product from your Pocket PC: 

1. Go to Start menu > Settings 

2. Open System and tap on Remove Programs 

3. Select Spb Pocket Plus from the list and tap on the Remove button 

4. Choose Yes to confirm removing 

http://www.spbsoftwarehouse.com/products/pocketplus/download.html
http://www.microsoft.com/windowsmobile/activesync/activesync45.mspx
http://www.microsoft.com/windowsmobile/devicecenter.mspx
http://www.microsoft.com/windowsmobile/devicecenter.mspx
http://www.spbsoftwarehouse.com/products/pocketplus/purchase.html
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Configuring Spb Pocket Plus  
After Spb Pocket Plus is installed on your Pocket PC it is ready 
to use. You can customize its settings and behavior(s). 

Spb Pocket Plus Settings 
You may customize Spb Pocket Plus to fit your needs. To 
begin go to system settings where you can find the Spb 

Pocket Plus  icon. Tap on it to open the settings page. 
The settings screen allows you to choose which modules to 
enable/disable using the check mark next to their 
icons. Highlighting an item by tapping on it enables the 
Feature Options button, allowing you to change the options 
for the chosen modules. 

Today Plug-In 
The Today Plug-In feature options allow you to customize and 
personalize your Today plug-in. It includes four tabs which 
you can use to adjust your settings.  

• Tabs tab: You can add, delete, add items to each tab, 
and organize your tabs. 

o To add a new tab, tap on the Add button and 
the new tab will be added in the list under the 
name Untitled.  

o To delete a tab, select it and tap on Delete. 

o To rename a tab, select it and tap on Rename. 
You can leave the tab name empty to show only 
the tab icon in the tab header. 

o To add and edit the items of your tab, select 
the desired tab and tap on Items. The items 
are organized by categories. Select a category 
and you will see the list of items in this 
category. Check/uncheck the items you want to 
see on your Today screen. The items list 
contains the following categories: 

 Indicators: This category contains the 
Spb Pocket Plus indicators (Battery 
Indicator, Backlight Indicator, Memory 
Indicator, and up to three Storage Card 
Indicators). 

 Programs: All items in your 
Start>Programs menu are available in 
this list. If you want to add programs 
that are not included, you can add their 
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executable files to the Custom category from the Add softkey.  

 My Documents: A list of all items in the My Documents folder. 

 System: Spb Pocket Plus specific 
system tools, such as a Soft-Reset 
button, Screen Off, Volume Up/Volume 
Down buttons, Theme Switching button, 
and other useful tools. 

 Settings: The list of your Pocket PC 
settings applets is shown. 

 Custom: This category can contain links 
to custom files and folders that you add. 
To add a file or a folder to this category, 
tap on Add softkey and select the 
desired file or folder from the menu. 

o Tap on Plug-Ins button to add third-party or 
any Spb applications plug-ins into the Spb 
Pocket Plus Today plug-in. You can add more 
than one plug-in in the same tab or as a 
separated tabs. Use the Move Up/Move Down 
buttons to change the order of the plug-ins and 
tap on Options… to open its options dialog if 
available. 

o Use Change Icon to select an icon for the tab 
header. You can select icons from five groups 
Custom, Custom2, Other Programs, Spb 
Programs and Standard. You also can change 
the name of the tab header or leave it empty to 
make the tab header contain only an icon. 

• Skin tab: Choose the indicators appearance from the 
skin drop-down list and see a preview before applying 
it. 

• Header tab: In this tab you will find the options to 
change the appearance of the tab header. 

o Choose the Tab header position from the 
drop-down list. You can put it either on the top 
or on the left side of the Today plug-in. 

o Choose the Tab header size from the drop-
down list. You can make the tab header and its 
icon either large or small. 

o Check Auto-hide tab content option to hide 
the tabs contents when not used and show 
them when you tap on the tab header. 
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o Check Realign tabs to sides in landscape 
option to automatically align the tabs headers 
to the left and right sides of the Today plug-in 
when you switch to the landscape mode. This 
option is only available if you set tabs headers 
size to large. 

• Advanced tab: Use this option to place Spb Pocket 
Plus Today plug-in on the top of the Today screen in 
the non-scrollable area. It will pin the Today plug-in at 
the top of the screen. 

Close Button 
The standard behavior of Windows Mobile is to minimize 
applications when the X-button is tapped. You can speed up 
your Pocket PC by closing running programs that take up a 
large amount of memory. Applications will be closed with 
single tap on the X-button. In addition, a task manager menu 
will appear if you tap-and-hold on the X-button. With the task 
manager you can easily switch between all active applications. 
The Close Button options include three tabs: 

• Menu: Here you can choose which items you want to 
appear in the context menu (the task manager) when 
you tap on the X-button. There is a wide range of 
features to choose from with check marks. Select the 
<Running Programs> item to see all active programs 
in the task manager menu so you can easily switch 
between them. Select the desired items and tap on 
Move Up/Move Down buttons to change the order of 
the items in the menu. 

• Close Button: Here you will see three menus. These menus determine the action 
performed when you tap, tap-and-hold, or gesture on the close button. 

• Exceptions: Here you can choose the programs which you want to be minimized, 
instead of closed, when the close button is tapped. 

Taskbar Battery Indicator 
The taskbar battery indicator allows you to see the battery 
power level in any application since it remains in the upper 
part of the screen (horizontal bar). It also can be displayed as 
an icon in the taskbar (except in full screen applications like 
games or movies). Choose whether you want the indicator 
bar height to be small, large or a battery icon on the taskbar. 
The battery indicator always takes on the color of the active 
theme of your device. 

Tip: To save space on your taskbar use the taskbar battery 
indicator in horizontal bar mode. In this mode the battery 
indicator will not take up an icon space on the taskbar. 
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Pocket Internet Explorer 
This feature adds essential tools and abilities to Pocket Internet Explorer providing a more 
pleasant internet browsing experience. You can open multiple Pocket Internet Explorer 
windows and switch between them using tabs at the top of the screen. You can also enable 
smart scrolling, view the source files of web pages and save them, save images, search 
quickly from the address bar, and browse web sites in full-screen mode. Here you can 
customize the following: 

• Change the behavior of the close button. You may have it close either all opened 
Pocket Internet Explorer windows or just the current window. 

• If you want to select the text from a webpage instead of scrolling, disable the 
Enable screen drag option. You will then be able to select the webpage text instead 
of scrolling only when you drag slowly. Dragging fast will still scroll the page if the 
Smart Scrolling feature is active. 

File Explorer 
This feature implements several very useful functions to File 
Explorer. You can enable or disable the features using their 
check marks. 

• Enable ZIP support: Select to enable compressing 
and decompressing files and folders.  

• Enable storage card format support: Select to be 
able to Format your storage card.  

• Enable “Add To Today Screen”: Select to add a 
shortcut on the Today screen for any file or folder you 
want. 

•  Enable encryption support: Select to encrypt and 
decrypt files and protect your privacy by adding a 
password to the encrypted file. 

• Add “Properties” to the context menu: Select to 
view the file properties or a group of files and folders 
properties right from the File Explorer.  

File Open/Save Dialog 
Enabling this option will extend the ability of the standard 
Windows Mobile File Open/Save dialog. So you can browse 
your folders at any level to open or save your files and folders 
on the storage card or the main memory. For example, if you 
want to save a file that you created using Word Mobile, tap on 
Save As… and select any folder at any level where you want 
to save the file to on the device or the storage card.  
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Buttons 
Extend your hardware button (ok button, camera, voice 
recorder) operations and assign them to any program or 
system utility. An example is to assign the press of the ok 
button to the [Close] program and the press-and-hold of the 
ok button to the [Close Button Context Menu] program. In 
this case you will be able to completely close the programs by 
one press and open the close button context menu (task 
manger) with a press-and-hold.   

• Program Buttons: This allows you to choose what 
hardware buttons you want to be available so that you 
can map them to an action in the list. You can assign 
two actions to the same button. The first for the press 
action and the second for a long press (hold) action. 
To assign the long press action to a hardware button 
you need to add it using the Add Button wizard. Tap on 
<Add buttons…> to start the add button wizard which include three steps: 

1. Press the button that you want to add. 

2. Press and hold the same button to verify and add the long press ability to it. 

3. Press ok to save the changes and exit. You will see the button you added 
with the (Long press) ability next to it. Select an action to assign from the 
programs list. 

Note: Standard keyboard buttons on sliding keyboard devices cannot be assigned to 
any action. Only the hardware buttons such as ok, camera, and recorder can be 
assigned to such programs.  

• Up/Down Control: This tab remains as it is with no change by Spb Pocket Plus. You 
can use it to set the repeating speed rate for the up/down buttons. 

Note: Spb Pocket Plus can recognize some devices and automatically add their buttons to 
the buttons list. In this case, the <Add buttons…> option will not be available. This is due to 
the variety of devices and the differences between hardware buttons availability.  

Safe Mode 
The purpose of Safe Mode is to allow you to troubleshoot 
Windows and determine what is causing it not to function 
correctly. Once you have corrected the problem, you can then 
reset and Windows will load normally. It may save you from 
using a hard reset procedure. The following is an example of 
how you might use Safe Mode. Say you install an application 
that is not compatible with your device or some other 
installed program starts causing problems in one way or 
another. However, it cannot be removed since it is already 
running.  So the only solution would be to hard reset. Now 
using the Safe Mode menu, you can simply boot your Pocket 
PC into safe mode which disables all Today plug-Ins, autorun 
applications and services, so you can easily remove the 
incompatible application. After that you can reset and boot in 
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normal mode. The safe mode feature has two options which you can choose from: 

• On every reset: Select to enable the safe mode menu to appear each time you 
reset your device. 

• If the system has worked for less than three minutes: Select to show the safe 
mode menu only when you reset within three minutes of the device booting.  

Smart Scrolling 
The Smart Scrolling feature allows you to scroll through lists, 
e-mails and surf the web making it a smoother, faster and 
more comfortable way to use your device. Control the speed 
of the scroll with your finger or stylus anywhere on the 
screen. For example, when you are surfing the web and you 
can’t see the full content of the webpage due to the screen 
size. With smart scrolling you can move any window's 
contents around by simply dragging your finger or the stylus. 
The Smart scrolling options include a check-mark list of 
applications for which you can enable or disable the feature. 

Tools menu  
Open the Tools menu to access additional settings and 
options.  You can save your Spb Pocket Plus settings to a file 
so they can be restored later from the Backup Settings… 
menu item. You can choose a file name and location. Use the 
Restore Settings… menu item to restore the program 
settings from a previously created backup file. The Uninstall 
Components… option allows you to delete unneeded or 
undesired modules. You can also delete individual parts of a 
module. This option will give you maximum control over your 
program’s memory. Finally you can see the Registration… 
and About… menu items which allow you to enter your serial 
number and get information about the product version and 
build. 
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Using Spb Pocket Plus  
Spb Pocket Plus has easy to use functions and tools. This 
chapter contains all the information you need to use the Spb 
Pocket Plus powerful features.  

Today Plug-In 
Spb Pocket Plus has a powerful Today plug-in with tabs that 
gives you the ability to launch applications and perform other 
frequent actions directly from the Today screen. You can add 
shortcuts allowing you to quickly open your favorite 
documents and programs, get quick access to settings and 
system tools, and to read the status of your battery, memory, 
backlight and storage card. You can organize shortcuts in tabs 
to save space on the Today screen. You can make the tab 
header show only an icon (This will help you navigate between the tabs and allow more tabs 
to fit on the screen). Plug-ins with dynamic icons can be 
added so you can see the tab status from its icon. Shortcuts 
can be dragged and dropped inside a tab or across tabs. Tabs 
can also be dragged to other positions. Perform the following 
tasks directly from your Today screen: 

Tab Header Context Menu 
Tap-and-hold on any tab header to open the tab header 
context menu. From this menu you can do the following: 
New Tab… (create a new tab), Delete Tab (delete a tab), 
Rename/Change Icon… (change the icon of or rename the 
tab), or Show Name (show or hide the tab name in the 
header). You can also add a Plug-In inside the tab area by 
choosing the plug-in from the Plug-Ins submenu, change the 
look of the tab headers from the View submenu (which 
includes Horizontal tabs view, Vertical tabs view, Large tabs, 
Auto-Hide Tabs Content, Realign in Landscape view mode), and change the look of all 
shortcuts and indicators in the tab from For All Items 
submenu (which includes Make Small, Make Large, Show 
Labels, Hide Labels). Select Options…to open Spb Pocket 
Plus settings dialog. 

Item Context Menu 
Tap-and-hold on any item to open the item context menu. At 
the top of the menu you will see the selected item’s name 
followed by the menu items to perform the following tasks: 
You can Arrange Items or set Auto Arrange to 
automatically re-arrange tab items after any action like drag-
and-drop, or adding and removing items. After you set all of 
your items in their places and you don’t want them to move 
any more check Lock All Items. To add or drag-and-drop 
items you must unlock them first. You can do that any time 
by tapping Lock All Items again. From the Add submenu 
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you can add Items, File, Folder or applet to the tab contents. Select Remove Item to 
delete the selected item. You can assign Large Icon to your important documents or 
applications. Check Show Label menu item to show the name of the item under its icon. 
Select Rename/Change Icon… to change the name or the icon displayed for the selected 
item. 

Today Plug-In Finger Navigation 
You can adjust and modify the Spb Pocket Plus Today plug-in 
to be easily browsed with your finger. To do so follow these 
steps: 

• Open any tab header context menu and select Large 
Tabs from the View submenu. 

• Open the tab header context menu again and select 
Make Large from the For All Items submenu. Also 
you can select Hide Labels from the same submenu 
to save space on your Today screen. 

• Add the items and files that you need the most to the 
tabs using Add submenu. We recommend that you 
add some of Spb Pocket Plus’ useful system items 
such as Soft-Reset, Screen off (to turn off your screen 
while keeping all your programs running normally to 
save your battery power consuming), Rotate Screen Left, and Rotate Screen Right. 

• After you have added your items you can organize them either using Auto Arrange or 
by drag-and-drop. Use Lock All Items to protect them from any inadvertent 
changes.  

• Enjoy navigating using your finger. 

Today Plug-In Minimum Screen Usage 
If you have one or more Today plug-in that you don’t want to 
integrate into Spb Pocket Plus Today plug-in tabs you can 
modify the settings so that the plug-in will use the minimum 
amount of screen space possible. To do so follow these steps: 

• Open any tab header context menu and unselect 
Large Tabs from the View submenu. 

• Open each tab header context menu again and select 
Make Small from the For All Items submenu. Also you 
will need to select Hide Labels from the same 
submenu to save space on your Today screen if the 
labels were shown. 

• Open any indicator context menu and select indicator 
skin that use small size icons from the Skin submenu. 

• If you still don’t have enough space, you can select 
Auto-Hide Tab Content feature from the View submenu in any tab header context 
menu. This feature will hide all of the Today plug-in items until you select them by 
tapping on the tab header. 
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Today Plug-In Landscape 
Make the Spb Pocket Plus Today plug-in easier to browse in 
Landscape mode. You can use the same settings described 
above if you want to use finger navigation or minimum screen 
usage in landscape mode. The only thing you need to set is 
the Realign in Landscape feature which can be selected 
from the View submenu in the tab header context menu. 

Today Plug-In (Plug-Ins) 
You can add plug-ins into the Spb Pocket Plus Today plug-in. 
More than one plug-in can be added to the same tab or as 
separate tabs. Some plug-ins do not require much space in 
the tab, so it is better to put them in the same tab with other 
plug-ins. For example you can make a new tab and select an 
icon for it. Then add to this tab a system plug-in, time plug-
in, and other programs shortcuts. Arrange the plug-ins order 
by using Move Up/Move Down buttons in the Today plug-in 
settings. 

Note: The previous Today plug-in settings were just an 
example of what you can do to get the most out of your 
Today screen. You can adjust Spb Pocket Plus Today plug-in 
according to your wants and needs. 

Indicator Items  
Spb Pocket Plus indicators display battery and memory 
condition at any time right form the Today screen. Included 
indicators are battery, memory (built-in storage), storage 
card, SD storage card, and a backlight (screen brightness 
control) indicators. When you tap on the indicator icon, it will 
open its corresponding system settings dialog and when you 
tap on the indicator status bar, it will change its display from 
amount to percentage. The battery indicator displays the 
battery power (voltage) or the estimated time remaining 
based on the usage statistics. The backlight indicator allows 
you to adjust the screen backlight by moving the slide-bar. 
When you tap-and-hold on indicator item, you will see a 
slightly different item context menu. Tap-and-hold on any 
indicator to open the indicator context menu. Tap on the Skin 
menu item and select the desired submenu item to change 
the indicators look and color. From the storage card context 
menu you can choose to show either the amount of free or 
used space on the status bar. 

Note: You can download additional indicator skins at no cost from Spb Software House 
website. 

http://www.spbsoftwarehouse.com/products/pocketplus/skins.html
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Theme Loop  
Theme Loop is a system tool that allows you to switch themes 

right from the Today screen by tapping on its icon . Each 
time you tap on the theme loop the next theme in your 
theme list will be applied. Open the theme loop context menu 
to select which theme you want to apply from the Select 
Theme submenu. Add this tool to your Today Plug-in from 
the System items category if it was not already there. 

Note: You can download themes at no cost from Spb Club 
web site at: www.spbclub.com  

 

Today Plug-In Screen Shoots Configuration 
Samples 

http://www.spbclub.com/
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Integration with Spb Products 
Integration of Spb Pocket plus with other Spb products allows data from the software to be 
read or manipulated by Spb Pocket Plus resulting in ease of use. Most of our products 
include Today plug-ins and some include applets designed specifically for use in Spb Pocket 
Plus. The Spb products applets must run in a container, which is provided by Spb Pocket 
Plus through the Today plug-in. Any applets existing on your device can be added from the 
items context menu.  

Pocket Internet Explorer  
Spb Pocket Plus enhances Pocket Internet Explorer by giving it the ability to save web pages 
and pictures, enables smart scrolling, fast searching, support multiple windows with tabs, 
full screen navigation and view the page source. These are very useful features that can 
enrich your on-road mobile surfing experience. You can quickly access the enhanced 
functions from either the Spb Pocket Plus icon on the toolbar or the Spb Pocket Plus 
submenu in the main menu. Tap on Options… at the end of 
both menus to open Spb Pocket Plus settings.  

• Search: Launch your search quickly. Type your search 
key word in the address bar then simply tap Search a 
menu item from the Spb Pocket Plus tool-bar icon. Spb 
Pocket Plus search uses the Google search engine. 

• Multiple windows with tabs: Spb Pocket Plus allows 
you to open several web sites simultaneously and shift 
between them using tabs at the top of the screen. You 
can open New Tab, Close Tab, Hide or Show Tabs 
header, switch between tabs using the Tabs submenu 
or from Spb Pocket Plus submenu in the main menu. 
Tap-and-hold on the tab header to open its context 
menu. From the tab header context menu you can 
close it, close other tabs and keep the selected tab, or 
open a new tab. Tap-and-hold on a link in the page to 
open its context menu and select Open in New Tab menu item to open its 
corresponding web page in new tab. You also can open a link web page in the 
background using Open in Background menu item, so you can keep surfing while 
downloading and opening the new web page.   

• Smart Scrolling: Use smart scrolling to Move the contents of any web page around 
with a simple finger or stylus drag to make browsing smoother, faster and more 
comfortable. If you want to select web page’s text instead of scrolling, disable the 
Enable screen drag option. You will be able to select web page’s text instead of 
scrolling only when you drag slowly. Dragging fast will scroll the contents of the web 
page. To completely disable this feature, go to the smart scrolling settings.  

• Save web pages and pictures: You can save web pages by selecting Save As… 
menu item from the Spb Pocket Plus submenu. To save a picture, tap-and-hold on it 
and select Save Image… from its context menu. This very handy feature helps you 
to keep a record while surfing out-doors. 

• Page source file: To view the page source file, select View Source menu item 
from Spb Pocket Plus submenu. 
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• Page Panning: Tap-and-hold anywhere in the web page and select the Page 
Panning menu item to enable the smart scrolling feature. Unselect Page Panning 
to select web page’s text instead of scrolling. 

• Full screen mode: You can view the webpage in full screen mode. Tap-and-hold 
anywhere in the web page and select Full Screen from the context menu. To return 
to the normal view mode, tap-and-hold anywhere in the web page and unselect the 
Full Screen menu item.  

Note: For advanced users it is possible to change Spb Pocket Plus’ search engine in Pocket 
Internet Explorer from Google to another search engine. For more information please 
contact technical support team. 

Close Button Context Menu (Task Manager) 
With the task manager you can minimize, close, close all, close all inactive applications, 
jump to Today screen, easily switch between all active applications, and open Spb Pocket 
Plus settings. You also can add variety of useful items to the menu such as suspend, screen 
off, volume control items, and backlight control items. The 
Task manager menu will appear by default if you tap-and-
hold on the X-button. You can make the task manager menu 
appear if you tap, tap-and-hold, or on gesture the X-button. 
To modify the menu items go to close button settings. 

Tip: You can adjust the task manager menu to switch quickly 
between active applications using only hardware buttons.  

• Assign a hardware button to open the close button 
context menu when you press-and-hold. 

• Check and move up the <Running Programs> item so 
they will appear in the top of the close button menu. 

• Now press-and-hold on the assigned button and select 
the application using up/down and action button. 

Hardware buttons 
Extend your hardware buttons (ok button, camera, voice 
recorder) operations and assign them to any program. An 
example of a good use is to assign the press of the ok button 
to the [Close] program and the press-and-hold of the ok 
button to the [Close Button Context Menu] program. In this 
case you will be able to completely close the programs with 
one press and open the close button context menu (task 
manger) by press-and-hold. Another useful ability to assign is 
the Switch Programs (alt-tab) action which quickly switches 
between active programs. If you have two or more 
applications running, press the button that you have assigned 
to alt-tab action and a task manager will appear in the middle 
of your screen showing you the icons and the names of the 
running applications. You can switch between programs using 
your left and right pad buttons or by the same button you 
had assigned. 

http://www.spbclub.com/forum/
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Open/Save Dialog Box 
The Open/Save dialog will extend the ability of the standard 
Windows file open/save dialog which allows you to see only 
the first level of the storage hierarchy. With Spb Pocket Plus 
you can browse your folders in any level to open or save your 
files and folders in main memory or the storage card. 

Note: All applications that do not have its own open/save 
approach will call Spb Pocket Plus open/save dialog and use it 
instead of the standard Windows open/save dialog. 

ZIP File 
You will find Add to ZIP File in every file or folder context 
menu and Extract in any ZIP file context menu. This allows 
you to quickly zip or unzip files and folders. 

Safe Mode 
The purpose of Safe Mode menu is to allow you to 
troubleshoot Windows and determine what is causing it to not 
function correctly. Once you have corrected the problem, then 
you can reset and Windows will load normally. To use this 
feature, you need to press-and-hold the action button or tap-
and-hold in the safe mode area when the safe mode menu 
appears in the Windows startup screen. After that you will get 
a massage telling you in which mode you are booting. If you 
see the safe mode menu and do not press or tap anything, 
your device will boot in normal mode. To adjust when the safe 
mode menu will appear go to the safe mode settings.  

File Properties 
You will be able to get the properties of any file or folder in 
File Explorer from its context menu. This feature allows you 
to:  

• View and change the file extension.  

• Read the information about the file or folder type such 
as, location, size, "created" and "updated" dates, and 
view and change file or folder attributes, such as 
"Read-Only", "Hidden", and "Archive". You can also 
read information about ROM and System files. 

Format the Storage Card 
To format your storage card tap-and-hold on it and select 
Format… menu item from the storage card context menu in 
the File Explorer. 
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File encryption 
Encrypt or decrypt files and protect your files by adding a 
password to the encrypted file. Choose the Encrypt File… 
menu item from any file context menu in File Explorer and 
you will be able to encrypt and decrypt files. You need to 
provide a password and confirm it. You also can check the 
Delete original file option to keep only the encrypted file 
instead of the original file then tap on the Encrypt button. To 
decrypt a file, tap on it and fill in your password. Check the 
Delete encrypted file option to keep only the decrypted file 
then tap on the Decrypt button. 

Note: Please be carful when you set the password to encrypt 
file. There is no way to restore your file if you forget the 
password. Choose a password that is hard to guess, yet easy 
to remember. 

Add a Shortcut to Today Screen 
Add a shortcut on the Today screen for any file or folder. Tap-and-hold on the desired file or 
folder and select Add to Today Screen from the context menu. 
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Technical Support 
This chapter contains technical support information. It includes all the information you need 
to assist you. 

About The Trial Version 
The trial version of Spb Pocket Plus includes all of the features available in the registered 
version. The trial version expires within 15 days after installation. You can use the trial 
version only to check how Spb Pocket Plus works. In order to keep using the software you 
need to purchase the license. There is no need to re-install the Spb Pocket Plus in order to 
use the full version. 

To obtain the serial number you need to purchase Spb Pocket Plus software license and you 
will receive your serial number by e-mail. For more information please visit our web site at: 
http://www.spbsoftwarehouse.com/support/general.html 

Contacting Technical Support 
Please take advantage of one of the Spb Software House free technical support options: 

• Consult the online help installed with your program. From any of Spb Pocket Plus 
screens select Help menu item from the Start menu.  

• Refer to the Frequently Asked Questions (FAQs) in the Support section of the Spb 
Software House Web site. The FAQs may have information and helpful hints that are 
more current than the User Manual: 
http://www.spbsoftwarehouse.com/products/pocketplus/faq.html 

• Ask your technical question or post your feature request in the forum to get a 
quicker reply directly from the developer team. Solutions to your problems are 
available 24 hours a day at no cost on the Spb Club web site. You must first register 
as a member before using Spb Club web support: http://www.spbclub.com/forum/  

Include the following information to help us isolate the problem: 

1. The type of the device that you are using.  

2. The software name and version number. Select Menu → About… to view the 
software name and version number (example: Spb Pocket Plus, version 4.0, 
Build 9445). 

3. Any error messages that accompany the problem. 

4. A brief description of how we can recreate the error. 

5. Your name and the preferred contacting method. 

http://www.spbsoftwarehouse.com/products/pocketplus/purchase.html
http://www.spbsoftwarehouse.com/support/general.html
http://www.spbsoftwarehouse.com/products/pocketplus/faq.html
http://www.spbclub.com/forum/
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